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Welcome

Welcome to the Malvern Zetasizer software reference manual. By now you should have installed
your system and have an understanding of the operational procedures involved when using the
instrument.
This manual has been designed to give a detailed description of the commands that are available
within the software. It gives details on what each of the commands within the menus does and
details on how to do it. Additional chapters at the end of this manual cover additional subjects
such as file management, communication between other applications and advanced
measurement features that have not been covered elsewhere.
Warning: You must remember that the Zetasizer or the samples to be
measured are potentially dangerous if misused. You must read the
Health and safety booklet before operating the system.

1.2

Systems covered by this manual

Zetasizer is a generic name given to a family of systems. Each system within the family uses the
same software and only vary in operation in small areas. For this reason this manual has been
written to cover more than one instrument.
This manual covers the operation of the Zetasizer 1000, 2000, 3000, 4000, 5000 and the 4700.
Within this manual reference may be made to the various people that will have access to the
instrument. Below is a list of these people and their responsibility:

1.3

Malvern personnel

Malvern personnel (service engineers, representatives etc.) have full access to the instrument
and are authorised to perform all service procedures that may require the removal of the covers.

1.3.1

Supervisor

The supervisor is the person responsible for the management/safety of the instrument and of its
operation. The supervisor can perform all user maintenance routines identified in the Getting
Started manual, including changing the fuses.

1.3.2

Operator

An operator is a person trained in the use of the instrument. The operator can perform all user
maintenance routines identified in the Getting Started manual except for changing the fuses.
Warning: Failure to follow the above guidelines could result in the
emission of laser radiation. Laser radiation can be harmful to the
body and can cause permanent eye damage.

1.4

Assumed information

Within this manual the Zetasizer system will be referred to as the “Zetasizer” or the “system”
unless the information given is for a particular instrument.
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1.5

Windows terms

It is important that you understand some Windows terms before reading further. (Note that US
spelling is used for some terms for compatibility)
Program - The Zetasizer software - it can also mean the Zetasizer Basic program used within
the main Zetasizer software.
Cursor or Pointer - The graphic - usually a pointer that is moved on the screen by operation of
the mouse.
Icon - The graphic on the desktop that represents a program.
Click - The mouse button is depressed and released. If this is not qualified with a button
description then assume it is the left button. ‘Clicking a button’ means click the left mouse button
with the cursor over the button
Double-click - Press and release the mouse button twice in quick succession. If this is not
qualified with a button description then assume it is the left button. Use the Mouse icon in Program
Managers Control Panel to change the double-click speed.
Dialogue Box - A window containing controls. The OK button accepts changes in the dialogue
box. The Cancel button closes the dialogue without accepting the changes.
Control - This can mean a graphic on a dialogue like a button, listbox, textbox etc.
Press or Select - This means click the mouse over a control or use the accelerator key (the
underlined letter) or use the Tab key to move the focus to a control then use the Enter key. Menu
items can be selected using the cursor keys in the same way.

ILL 1992

Button - This acts like a real-life button. Click to carry out an action. A typical button is shown
below.

ILL 1993

Option Button or Radio Button - A series of buttons in a group, selecting one button cancels the
others in the group. A radio button is shown below.

ILL 1994

Check Box - A button that can be toggled on and off. A check box is show below.

ILL 1995

Text Box or Edit Box - A box you can type text or values into. A text box is shown below.

List Box - A box containing a list of options. Some List Boxes allow multiple entries to be selected.
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Combination List Box or Combo Box - A combination of a list box with a text box. A button beside
the text box displays or hides the list part of the control. In some cases you can type new values
into the text box part, in others the text box just shows the current selection from the list.

Drag - An action with the mouse which involves moving the mouse while holding down the left
mouse button. This is used for moving icons or making multiple selections in a list box.

1.6

Menu commands

Menu commands from the Malvern software are referred to in the form main menu-menu item.
As an example, the command File-Save Sample refers to selecting the Save Sample item in the
File menu. The same rules apply for sub-menus of sub-menus, so that Edit-Copy-Data refers to
the Data item in the Copy sub-menu, which itself is a sub-menu of the Edit menu. Menu
commands are always shown in bold text.

1.7

Where to find information

This manual details the commands that are available within the Malvern software. Each menu
from the software has its own chapter within this manual that takes each of the menu items in
tern and describes its function and how to use it.
Other chapters at the end of the manual gives details on features of the software that have not
been covered else where.
On-line help can be gained at any point when using the Malvern software. See the section below
for more details.

1.8

Getting help

1.8.1

On-line help

Microsoft Windows contains a help program which can give information on using Windows itself
and on programs that use Windows. As well as leafing through the manuals to find out how to
do something you can also refer to the on-line Help system.
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1.8.2

The F1 function key

You can get help on using the Zetasizer software at any point by pressing the F1 function key.
If the main Zetasizer window is active then the Help Contents page will be shown. If a dialogue
box or other Zetasizer window is active then help on using that window will appear. This ability
to give help on the operation being carried out is known as ‘context-sensitive help’.
To get help on the main Zetasizer window hold down the Shift key and press F1. The mouse
cursor then changes from the normal arrow to the Help cursor.
When the Help cursor is active clicking the left mouse button over a component of the Zetasizer
window will show help on that component. If a menu is selected or a button in the toolbar is
clicked then help will appear on that command.

1.8.3

The Help menu

The far right menu in the Zetasizer menu bar is for Help. This allows you to go directly to specific
parts of the Help system. The Help menu items are:
Contents - The main list of contents in the Help system.
Menu Command - The list of menu commands.
Program Language - The contents of the help on using the built-in Zetasizer Basic language
(program mode).
Keyboard - How to use the keyboard for; commands, moving the splitter bar of the window and
changing the scale the graph etc.
Window - The list of Zetasizer window components.
Help - This command displays the Microsoft Help information on using the Help system.
For more information on the commands in the Help menu see chapter 10.

1.8.4

The Help window

The Help window is an independent window with its own menu and sizing border. If you have
the Zetasizer window maximised (filling the whole screen) you may find it useful to make the help
window always stay on top of the Zetasizer window.
To set the Help window to be always on top:
l
l

Select the Help menu item from the Help window.
If the Always on Top item does not have a check mark against it then click this item (or press
the Enter key with this item highlighted).

The Help window has a row of buttons below the menu for the most used actions:
Contents - Pressing this button send you to the main contents page.
Search - Selecting this displays the search dialogue - Searching Help.
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To search for the required information:
l
l

Type the first few letters of the item to search for in the text box. The list box scrolls to show
the item.
Double-click the item in the list or press Show Topics. The list box at the bottom of the
dialogue shows one or more topics.

l

Select the topic in the bottom list box. Double-click or press Go To.

l

The help window changes to the topic.
Back - Pressing this button moves you to the last help topic displayed.
History - This button displays a window showing a list of help topics visited. Double-click an
item to go back to that topic.
“<<” and “>>” - These are the browse buttons - click these to see related topics to the current
one.
Glossary - Shows a list of glossary items. Click these to see the descriptions.

1.8.5

Jumps and popups

In the Help window you will see text which is underlined with a solid line for example Zeta mode.
Click this to move to another topic. This is known as a jump.
Text that is underlined with a dotted line will show a popup window with extra information when
it is clicked with the mouse. Click the mouse in the window to make it disappear. This is known
as a popup.
When the mouse cursor moves over a jump or popup item it changes to the help jump cursor.
The cursor also changes when it moves over certain graphics and buttons. Clicking these items
show more information about them.

1.8.6

Status line

When a menu is selected or the mouse cursor moves over a toolbar button the status line at the
bottom of the Zetasizer window will show information on the command.

1.9

Reporting problems

Before reporting a problem please check the relevant sections of the user and reference manuals,
or any accessory manuals, which may have an answer. If the problem persists try to give as
much detail as possible.
If there is a problem in the software try to give information that will allow the engineers at Malvern
to reproduce the conditions. If the problem is in the measurement or the analysis the Malvern
engineers will require a copy of the Data or diagnostic report called Fullzeta.pcp or Fullsize.pcp.
A list of the Malvern subsidiaries can be found within the appendices of the Getting Started
manual.
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To print a Diagnostic report:
l
l
l

Go to the File-Print menu.
From Setup report select Fullzeta.pcp for a zeta potential report or Fullsize.pcp for a size
report.
Select OK, then Print.

1.10

Right mouse button

Extensive use is made in this software of the right mouse button. It gives fast access to a number
of useful functions.
For example:
l

When clicked to the left of the graph, the cursor can be dragged to surround peaks.

l

Under the graph for changing scales.

l

On the table, in the graph key etc.

1.11

Other reading

More detail on the subjects within this manual can be found in the following manuals:
Making a Size measurement:

MAN0149

Making Zetapotential measurements

MAN0150

Zetasizer Hardware:

MAN0151

PCS Theory:

MAN0152

:
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Introduction to this chapter

This chapter sets out to give a brief overview of the features of the Malvern software. The chapter
will give details on:
l

Features of the Malvern screen.

l

Modes of operation.

2.2

The Malvern software

The Malvern software controls all the functions of the optical unit during a measurement and then
uses the data collected to calculate the result.
The software is Windows based, requiring version 3.1 or greater and has been designed to follow
the guidelines laid down by Microsoft regarding the way in which the software is operated and
how it co-operates with other Windows programs. Remember that, although the software is often
operated using the mouse, all of the measurement functions are accessible by using the keyboard
alone.
If you are unfamiliar with using the Microsoft Windows environment you should read the Microsoft
Windows manual. Running the Microsoft Windows tutorial will allow you to practice your mouse
skills.

2.3

The Zetasizer program group

Ill 4330

When the Zetasizer software is installed the Zetasizer program group shown below will appear
in the Program Manager window.

There are three program icons within the program group. On installation these icons are labelled
“Easy”, “Standard” and “Advanced”. The following chapters 2-8 assume the “Advanced” icon has
been selected. The description of functions also apply to the “Easy” and “Standard” modes, but
some options will not be available.

2.4

Finding your way around the screen

Before we explain the software in detail you should familiarise yourself with some of the key
features of the screen by using the diagram below.
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8

The main features are:
À Title bar (or caption)
This shows the name of the program (PCS) and, among other things, tells you the name of the
current sample file.
Á Menu bar
The menu bar contains the main menu headings for all Zetasizer functions.
There are several ways to select an item from the menu bar:
Using the mouse
To select an item from the menu bar use the left mouse button to click once on the menu item.
The menu list will drop down. You can then select the item from the menu list by clicking once
on the item.
By using the right mouse button, you can click to the right of the toolbar buttons to add/remove/edit
buttons, and by clicking on the keybar, you can customise the headings. Wherever plot or new
plot appears, clicking the right mouse button over them, a menu appears giving the options
available.
Using the keyboard
To select an item from the menu bar using the keyboard, hold down the Alt key and press the
letter which is underlined in the item required. For example to use the Measure menu hold down
Alt and press m. Whenever you use a key in this way it does not matter if you use upper or lower
case. M or m would both work.
Again a menu list will drop down. To select an item from the list type the letter that is underlined.
For example, typing d will select the Document... item to enter sample details.
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Using keyboard accelerators
To the right of a menu item name there may also be a note of the accelerator for this item. This
is a key or combination of keys which can be used to by-pass the menus. For example you can
press Ctrl and N together to select Measure-Document... without having to use the main menu
and drop down menu.
The items which end with a row of dots (...) will cause dialog boxes to appear. Those with no
dots will cause an immediate action. For example Document... displays a dialogue for you to
enter details but Clean would cause the sample handling unit to begin a cleaning sequence
without any further action.
Some items are shown in grey. This indicates that the choice is not currently available. For
example, the Clean item may be grey because no sample handling unit is installed and the
Background, Inspect and Sample items may be grey because these operations may not be
performed until the system has been aligned.
Â Button bar
The Easy button bar (or toolbar) contains a selection of buttons which you can use to perform
the most popular operations. Each button will have its equivalent commands within the menu
bar. See Control-Easy Buttons in chapter 7 to change the layout of the buttons and the pictures
that are used. You can also hide the key description which appears below the buttons.
When a button is pointed at, a small box will appear that gives the buttons function. The status
bar (seeÆ) sometimes gives a fuller description.

2.4.1

Summary of the functions of the Toolbar buttons

The following list is available in“ Advanced” mode. Some systems and “Easy” mode will not have
all these functions available. This list can be modified by referring to the instructions in chapter 7.
- Zetamode: Sets the system into zeta potential mode.
- Size mode: Sets the system into size mode.
- Measurement wizard: Guides the user through a complete measurement.
- Sample details: Alternative method of entering the sample details.
- Measurement details: Alternative method of entering measurement details.
- Check signal: Enables the check of sample count rate before the start of the
measurement.
- Start: Starts a measurement.
- Abort: Aborts a measurement if a mistake has been made.
Note: In zeta potential mode the run can only be stopped during the
Data accumulation part of the sequence.
- Print: Print a graph, table or report.
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- Open file: Examines the existing data on disk or change the currently open file.
- Display current records: Displays the contents of the live records buffer.
- Start ISO13321 measurement procedure.
- Exit program: Ends the program at the end of a measurement session.
Note: Before doing this useful data in the live buffer should be saved
to disk.
- Only available for the Zetasizer 3000, this activates a macro that uses the
scattering beam normally used for zeta potential measurements, at about 12 degrees, for
size measurements.
Ã Table pane
The table pane is used to show the result information in tabular form. Other information relevant
to the measurement will also be shown. The type of information displayed in the table pane is
determined by the “view”. The software has a list of standard views that can be easily changed
by the user. Custom views can be created by the advanced user.
To select a view, either select the View menu item or move the mouse cursor to any part of the
table pane and press the right mouse button. This action will display a pop-up menu which shows
you the selection of views available. Once selected the table and graph pages will immediately
update. See chapter 7 for details of the views available.
Double-clicking the left mouse button in the table pane has the effect of temporarily expanding
that page to fill the window. Double-click again to restore the split screen. Scroll bars appear on
the table pane if the pane is too small to show the whole table.
Ä Graph pane
When a different view is selected the graph pane automatically changes to represent the data
in the table. The graph pane always shows the same result but there are options to change the
way it is displayed, for example the graph can be shown as a intensity, number or correlogram.
Plots of the same type may be overplotted.
The form of each graph may be modified by clicking the right mouse button over the graph pane
(or by selecting the Setup-Graph menu item). This produces a dialogue that allows plot styles,
axes and colours to be changed. See Setup-Graph in the software reference manual for more
information.
Double-clicking the left mouse button in the graph pane has the effect of temporarily expanding
that pane to fill the window. Double-click again to restore the split screen. The graph will
automatically fit the graph pane.
Å Splitter bar
The splitter bar allows you to change the proportions of graph and table panes i.e. to make the
graph or table pane bigger or smaller.
To move the split between graph and table panes using the mouse, move the cursor onto the
splitter bar - the arrow cursor will change to a double-headed arrow. Now, hold down the left
mouse button and drag the bar to the new position. Release the mouse button when the desired
position is reached.
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The splitter bar may also be controlled from the keyboard or from the menus.
Æ Status bar
The status bar is split into two parts. The left hand section is used to show the status of the
software. It usually shows the message Ready - Press F1 for Help. This will change to inform
you when the system is loading or saving files, calculating, etc. As a menu is selected or the
cursor moves over a toolbar button help information is shown.
The right hand part of the status bar shows the instrument status. The instrument status bar
shows Instrument Connected if the optical unit is correctly connected and switched on and
Instrument Not Connected otherwise. The instrument status bar will also show the progress of
a measurement.

Ill 4335

Ç User configurable keybar
The headings in the keybar can be customised and saved in a configuration file. Use the right
mouse button within the keybar area.

2.5

Modes of operation

The Malvern software has three main modes of operation, Easy, Menu and program mode, which
are summarised below.

2.5.1

Toolbar

The Easy button bar (or Toolbar) provides a simple way to select frequently used actions. For
most samples a full analysis of a sample can be made by using the buttons. The buttons can be
used by relatively inexperienced operators. By using the right mouse button, you can click to the
right of the toolbar buttons to add/remove/edit buttons, and by clicking on the keybar, you can
customise the headings.
In the following chapters if a menu item has a button or icon to access the function directly this
is pictured at the beginning of the section.
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Note: In “Easy” and “Standard” mode not all icons will be available.

2.5.2

Menu mode

Menu mode is the use of the menu bar and its options to control the Zetasizer. Using the menus
gives you access to all functions of the software. Full details of all the options in the menus are
detailed later.

2.5.3

Program mode

The program mode uses the built-in program language “Malvern Basic” to allow you to build
complex measurement sequences with prompts to enter values, perform actions, etc. and
detailed checking of error conditions. Such programs may be run individually, assigned to single
key operations or set up to run automatically when the software starts.
The Malvern basic language is an advanced feature that is usually used by the more experienced
user.
Full details of programming in the Malvern Basic language are given in the Malvern Basic manual.
The three modes above are designed so they can be used in conjunction with each other. You
may find that you only need to use the Easy mode buttons or just the menu items but it is possible
to use all modes in a single measurement.
Always remember, as with most modern Windows programs, there is usually more that one way
to operate the software. A function like printing a report for example can be done in several ways;
by using the print option in the File menu, pressing the print button in the button bar or using the
keyboard by pressing the F11 key.
Once you have gained experience in the operation of the Zetasizer it will be normal for you to
set up automatic sequences of measurements that will automatically go from one procedure to
the next, pausing only for you to enter details. To do this you set up a measurement “sequence”.
The software also allows manual control of each stage. Even in manual control the system will
take you from one stage to the next logical stage using a single key action. The system also
locks-out actions that may lead to invalid measurements and gives warnings if measurements
are not within accepted limits.
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Introduction to the File menu

The File menu contains the file handling commands. Using the commands within this menu allows
you to:
l

Create new Size, Zeta or Intensity window

l

Open and save records and sample files.

l

Open CONTIN records from last analysis

l

Load and save system configuration files.

l

Process several sample records etc.

l

Print files and setup printers.

l

Exit the program

ILL 3790

The File menu is shown below.

Each of the menu items are now described in detail.

3.2

File - New

This menu allows the user to create a new measurement window of his preference. It is necessary
to have a window of the required type to perform any action that involves measurement or data
of that type. For example, to perform a size measurement, it is necessary to open a Size Window.
When the File-New menu is selected a pull out menu will appear giving the options of:
Size Window
Zeta Window
Intensity Window
Note that all three menu items may not be available.
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Normally the user will require only one window of the required type, however multiple of windows
of each type are possible, and are often useful for side by side comparison of different data sets.

3.3

File - Open Sample File and Load Record

This command (press the
button on the toolbar) allows new and existing sample files to be
opened or one or more records to be loaded or processed. There are also the following facilities:
Process multiple records.
Record deletion.
View information on records.
Record plotting.
Record printing.
Loading records to the Live Records buffer.
When the menu item is selected the following Dialog appears. The key features of the Dialog
are identified and explained:
3

1

2

4
6
7
8
9
5

10

12

ILL 3796

11

À File Name
The File Name edit box displays the sample file that is currently selected. The sample file can
be changed by selecting an alternative from the Files list box. Sample files have the extension
.SAM which is automatically added when a new file is saved. Once selected click the OK button
to open the file or select List
Records to list the records within the sample file.
Á Directories
The Directories list box displays the directories on the computer. When the system is first
installed the sample files are contained in the Data sub-directory[..] is the directory up one level
in the directory hierarchy.

Page 3.2

Zetasizer 1000/2000/3000/4000/5000/4700
Artisan Scientific - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisan-scientific.com

The File menu

MAN 0160

Â Files
The Files list box lists the sample files that are available within the currently selected directory.
Ã List Records
When the List Record button is pressed all records that are in the selected sample file will be
displayed in the Records list box. You can also do this by double-clicking on the file name in the
Files list.
Ä Records
The Records list box lists the records in the current sample file. Use the List Records button to
list the records.
Å Edit
Processing the edit button enables the Edit parameters dialog. It allows the modification of key
parameters in the last selected record in the Records list box
When the edit button is selected a dialog appears. For details of this dialog see the Measure
Document Dialog, which is virtually identical. The only differences are that in the present dialog
all parameters are editable, and the Setup measurement buttons and Select sample buttons are
disabled.
Æ Load
The records selected in the Records list box are loaded into the Live Records buffer. The contents
of the Live Record buffer can be displayed using the View -Live Records dialog. See the entry
under the View menu.
Ç Print
Pressing this button schedules the printing of selected records using the current print options.
È Add Plot
Plots the currently selected records onto the current window, without clearing the existing axes.
If the left mouse button is used, the current plotting style is used. If the right mouse button is
used, a floating menu appears, the same as the Add plot popup menus under the View menu
item.
É New Plot
Plots the currently selected records onto the current window, clearing the existing axes. If the
left mouse button is used, the current plotting style is used. If the right mouse button is used, a
floating menu appears, the same as the New plot popup menus under the View menu item.

5 Analyse
Analyses the currently selected records in the Record list. If the left mouse button is used the
current analysis options are used. Otherwise the Setup Analysis dialog is invoked.

6 Delete Records

The currently selected records are deleted if this button is pressed. You are prompted for
confirmation before the records are deleted.
In intensity mode the buttons will be different. If the instrument can not change the angle then
there will be no analyse button. If the instrument is a spectrometer (i.e. 4700), clicking on analyse
will bring up a floating menu with the following options,
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ZimmPlot - Performs a Zimm plot calculation of molecular weight and radius of gyration..
Guinier plot - Performs a Guinier plot calculation of molecular weight and radius of gyration..
Debye plot - Performs a Debye plot calculation of molecular weight and radius of gyration..
There will also be an additional button. Edit angles, which will enable you to change the selection
of angles used in the analysis.

3.3.1

How to use the “Open Sample File and Select Record” Dialog

To create a new sample file:
l

Move to the desired drive and directory by using the Directory list box.

l

Type in the name of the file in the File Name edit box. You do not need to add the extension.

l

Click the OK button. You will be advised to confirm creation of a new file.

The new sample file is now ready for saving records.
To open an existing sample file ready for saving:
l

Move to the desired drive and directory by using the Directory list box.

l

Select the file from the Files list box.

l

Click the OK button.

The existing sample file is open for saving records.
To open a file and load a record:
l

Move to the desired drive and directory by using the Directory list box.

l

Select the sample file from the Files list box. Click the List Records but- ton.

l
l

Select one or more records in the Records list box. Select non-sequential records by holding
down the Ctrl key while clicking on the record.
Click the OK button.

To get information on a record:
l

Move to the desired drive and directory by using the Directory list box.

l

Select the sample file from the Files list box. Click the List Records button.

l

Select a record from the Records list box.

l

Click the Edit button. A Dialog appears giving details of the record including sample
documentation, the date and time of the measure- and other useful information. Click the
OK button to return to the Open file and select record Dialog.

To analyse more than one record:
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l

Move to the desired drive and directory by using the Directory list box.

l

Select the sample file from the Files list box. Click the List Records button.

l

Select one or more records from the list.

l
l

MAN 0160

The Records list box. Select non-sequential records by holding down the Ctrl key while
clicking on the records.
Click the Analyse button to set the actions to be performed on each record. See
Setup-Analysis in chapter 8 for details of the process dialog.

To delete a record:
l

Move to the desired drive and directory by using the Directory list box.

l

Select the sample file from the Files list box. Click the List Records button.

l
l

Select one or more records from the Records list box. Select multiple records by holding
down the Ctrl key while clicking on the records.
Click the Delete Records button. You are asked for confirmation before the records are
deleted.
Note: This function is not available in “Standard” or “Easy”
operating modes.

3.3.2

Tips for using the “Open Sample File and Select Record” Dialog

The easiest way to select directories, sample files and records from the list boxes is with the
mouse.
Double-click on an entry in the Directory list box to open that directory and list the sample files
in it.
Double-click on an entry in the Files list box to open that file and list the records in it.

3.4

File - Contin Records

This dialog is only applicable in Size mode and if the CONTIN option is installed. The results
displayed are those calculated from the last Contin analysis. This is normally about 25 solutions,
of which the last is the chosen one, which will have been saved to the Live Records by default.
Other solutions of differing smoothness may be interest, as the standard choice is rather
conservative in the degree of smoothness applied. The smoothness is controlled by the Alpha
parameters. The lower the value of Alpha the less smooth the result. The statistic on which the
most probable solution is chosen is called the probability to reject. It ranges from 0 to 1, the
optimum value is 0.5. The list box enables multiple selections of records to be made.
A typical screen shot is displayed below.
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3.4.1

Edit

Enables a full display of parameters associated with the record. This dialog is the same as used
by the File -Open Edit dialog.

3.4.2

Save

Transfers any selected records to the Live records buffer for plotting and further manipulation.

3.5

File - Reset Defaults

Using this command resets all parameters, including colours, fonts, analysis parameters to their
original values.

3.6

File - Load Configuration

When the Zetasizer is closed down you are given the option of saving the current configuration.
This means that when the Zetasizer software is next started it will be set up the same way as
when last closed down.
The configuration files have a file extension INI and usually reside in the same directory as the
main PCS program - PCS.EXE.
You may save and load your own configuration files that may contain, for example, configurations
for particular samples.
When the Load Configuration menu item is selected the Dialog below appears. The key features
of the Dialog are identified and explained.
1

2

ILL 3798

3
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À File Name
The File Name edit box gives the name of the currently selected configuration file. Type in a new
name to save the current configuration under a different name. The INI extension is automatically
added.
Á Folders
The Directories list box displays the directories on the computer[..] is the directory up one level
in the directory hierarchy. The current directory is shown above the folder list box.
Â Files
The Files list box lists the configuration files that are available within the currently selected
directory.

3.6.1

How to use the “Load configuration file” Dialog

To load a configuration file:
l

Select a file from the Files list box.

or,
l

l

Type a valid file name in the File Name edit box. The file extension will be added
automatically. You can also use wild cards as a template for files to be listed in the Files list
box. Type *.INI for a list of configuration files.
Select OK.

To select a file from a different directory:
l

Change to a different directory or drive by selecting from the Directories list box.

l

Select a file from the Files list box.

or,
l

l

3.7

Type a valid file name in the File Name edit box. The file extension will be added
automatically. You can also use wild cards as a template for files to be listed in the Files list
box. Type *.INI for a list of configuration files.
Select OK.

File - Save Config

When the Zetasizer is closed down you are given the option of saving the current configuration.
This means that when the Zetasizer software is next started it will be set up the same way as
when last closed down, including having the last result record loaded and displayed.
The configuration files have a file extension INI and usually reside in the same directory as the
main PCS program - PCS.EXE..
The Save Configuration As menu item allows you to save your own configuration files that may
contain, for example, configurations for particular samples.
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When the Save Configuration As menu item is selected the Dialog below appears. The key
features of the Dialog are identified and explained.
2

ILL 3799

1

3

À File Name
The File Name edit box displays the configuration file that is currently selected. A new name for
a configuration file can be typed into the File Name edit box
Configuration files have the extension .INI which is automatically added when the file is saved.
Type *.INI to see a list of configuration files or use the ? wildcard to refine the list. Once selected
click the OK button to open the file.
Á Folders
The Directories list box displays the directories on the computer[..] is the directory up one level
in the directory hierarchy. The current directory is shown beside the File Name edit box.
Â Files
The Files list box lists the configuration files that are available within the currently selected
directory.

3.7.1

How to use the “Save Configuration File” Dialog

To save a configuration file:
l

Select a file from the Files box to over-write an existing configuration file

or,
l

l

Type a valid file name in the File Name box. The file extension will be added automatically.
You can also use wild cards as a template for files to be listed in the Files box. Type *.INI
for a list of configuration files.
Select OK

To save a file to a different directory:
l
l

Change to a different directory or drive by selecting from the Directories box. If you do not
have a mouse use the Change Directory button to change the drive and directory.
Select a file from the Files box to over-write an existing configuration file.
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or,
l

l

3.8

Type a valid file name in the File Name box. The file extension will be added automatically.
You can also use wild cards as a template for files to be listed in the Files box. Type *.INI
for a list of configuration files.
Select OK.

File - Print

The Print menu item
allows graphs, tables, reports to be printed. The Setup Printer Dialog
can also be accessed under File-Printer Setup. To close the dialog and retain any modifications,
click on OK. To exit and not save any changes click cancel. If Print is selected then the current
settings are saved and the current options are printed.
When the Print menu is selected the Dialog below appears. The key features of the Dialog are
identified and explained.
2

6

3
5
4

ILL 3800

1

À Report
If the Report check box is selected then a report defined for the current View will be printed.
Á Graph
If the Graph check box is selected then a copy of the current graph will be printed. The graph is
scaled to the size set by the Graph Size option buttons.
Â Table
If the Table check box is selected then a table defined for the current View will be printed
Ã Key
If the Graph check box is selected then the option of printing a key is available.
Ä Title
If this checkbox is selected then the sample details are printed out. If other options are selected
this is the first item to be printed.
Å Graph Size
If a graph has been selected to be printed then the Graph Size option buttons allows the size of
the graph to be chosen. The options are:
Full Page - graph fills the page. Use this option if the graph is to be printed in landscape
view.
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Half Page - graph fills half the page
Fit to Page - the graph is fitted under the table on the same page. This option is disabled
if a table is not to be printed.
Æ Setup Report
This calls the Setup Report dialog, allowing you to change the report program that defines the
current report.

3.8.1

How to use the “Print” Dialog

To print a report:
l

Select the Printer Setup button to change the printer, if required, and the page orientation.
Reports are usually designed for portrait orientation.

l

Select OK.

l

Select File - Page setup.

l

Set the margins, page number, draft quality and use colour as required.

l

Select OK.

l

Select Print.

l

Select the Setup Report check box. Clear the other print item check boxes.

l

Select Print to print the report.

To print a graph:
l

Select the File - Printer Setup button to change the printer, if required, and the page
orientation.

l

Select the File - Print and select the graph check box. Clear the other print item check boxes.

l

Set the size of the graph by selecting one of the options in Graph Size.

l

Select the File - Page Setup.

l

Set the margins, page number, draft quality and use colour as required.

l

Select File - Print to start printing.

To print a table:
Select File - Printer Setup to change the printer, if required, and the page orientation. Tables are
usually designed for portrait orientation.
l

Select the File - Print and select the Table check box. Clear the other print item check boxes.

l

Select the File - Page Setup.
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l

Set the margins, page number, draft quality and use colour as required.

l

Select Print to start printing.

3.9

File - Printer Setup

This calls a dialog which enables you to alter the setup of the system printer. You can for example
select between landscape and portrait configuration or select a different printer from the list of
possibilities.

3.10

File - Page Setup

The File Page Setup allows the configuration of the page layout in printed reports and graphs.
3

1

5

ILL 3801

4

2

À Page margins
The group of page margin edit boxes allows the margins on the printed page to be set. The
options are:
Left - Set the left page margin in whole number of millimetres - up to 100.
Right - Set the right page margin in whole number of millimetres - up to 100.
Top - Set the top page margin in whole number of millimetres - up to 100.
Bottom - Set the bottom page margin in whole number of millimetres - up to 100. Each
page has a footer at the bottom containing details such as the instrument serial number
and the current date. If this footer is close to the bottom of the page, or cut off, then
increase the bottom margin.
Á Use Colour
Select the Use Colour check box to enable colour printing. This option will only be available if
the printer is capable of printing in colour.
Â Page Numbers
If the Page Numbers check box is selected then page numbers are added to the footer. Set the
starting page number in the Starting At edit box. The page number is automatically incremented
after each print.
Ã Page Footer
Allows modification of the font used to print the page footer.
Ä Footer text
The user can change the footer text as desired.

Page 3.11
Artisan Scientific - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisan-scientific.com

MAN0160

3.11

File - Exit

Quit from the program
current configuration.
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Introduction to the Edit menu

The Edit menu allows copying and amendment of the result. The menu allows you to:
l

Copy results, graphs, reports and DDE links to the Windows clipboard.

l

Paste data and results from the clipboard.

ILL 3789

The Edit menu is show below.

Each of the menu items are now described in detail.

4.2

Edit - Copy Graph

Clicking this menu item will paste a copy of the current graph displayed to the Windows clipboard
as a Windows metafile (*.Wmf). From here the metafile can be copied to any application capable
of displaying metafiles, for example Microsoft Word or Excel.
If the image is pasted into an application such as Microsoft Word you can double-click on the
image and edit it using the built-in graphics editor. This will allow you to change the colours of
the curves, change the fill styles or text sizes etc.

4.3

Edit - Copy Table

When the Copy Table menu item is selected, a pull out menu will appear giving the following
options:
As Picture
This copies the current table to the clipboard as a metafile. The comments given for the
Copy Graph menu are applicable here.
If the image is pasted into an application such as Microsoft Word you can double-click on the
image and edit it using the built-in graphics editor. This will allow you to change the colours of
the blocks, change the font styles or sizes, remove unwanted sections of information, etc.
As Text
This copies the current table as text to the clipboard. It can be then pasted to any
application that can import text, such as Excel, Word or even Notepad. More importantly,
columns are tab separated allowing Excel to format columns into spreadsheet columns.
A typical operation would involve copying the result from the Zetasizer to a spreadsheet,
performing some operations on it and then performing some reporting procedure.
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4.4

Edit - Copy Link

This menu item copies a string containing the application name, the topic of conversation and
the item for a Dynamic Data Exchange (DDE) link to the clipboard. The program run is called
DDELINK.pcm
l

The application name (or service name) is: Malvern PCS.

l

The topic is: data.

l

The item is: prog.

This string is usually picked up by another application with a command Edit - Paste Link or Edit
- Paste Special which initiates a DDE hot link. In a link of this type, whenever the result or data
changes, the partner application will be informed of the change via the DDE link. For more details
see chapter 11.
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Introduction to the Measure menu

The Measure menu controls the measurement of the sample. The menu allows you to:
l

Set up a measurement sequence

l

Start a sequence of measurements.

l

Document a measurement.

l

Start and Stop the optics unit

ILL3791

The Measure menu is shown below.

Each of the menu items are now described in detail.

5.2

Measure Wizard

This Wizard
guides you through the configuration of a measurement sequence by a
sequence of dialogs prompting you for information. Once you have completed this sequence you
can run measurements with these settings by selecting the “Run” button on the last page or by
selecting the “end” and then use the start sequence menu item. Each of the dialogs will have a
cancel button, allowing you to abort the sequence at any time, and two buttons , Prev and next.
Prev moves you to the previous dialog in the sequence (in case you wish to change something.
Next moves you to the next dialog. It is not available in intensity mode.
These dialog boxes contain all the essential information required by the system to make a
measurement. Any settings not requested by this sequence are left at their default settings.

5.2.1

Sample Details Dialog

ILL 3804

The initial dialog is shown below:-
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You are required to fill in your name and the sample name before moving to the next dialog, and
optionally any details concerning the sample or its preparation.
The sample name will appear in line 1 of the report, the sample details in line 2, and the operators
name will appear in line 3 of the report.
The next dialog prompts you for information about your sample, and the experimental setup. It
will be different depending on whether you are in sizing mode, or zeta potential mode.

5.2.2

Sample Parameters (Size mode)

In Sizing mode the dialog will have the following appearance.
3

1

2
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5

4

The input parameters are described as follows.
À Angle
This is only appropriate on instruments which supports multi-angle measurements.
Á Requested Temperature
This is the temperature at which you wish to perform your experiment. If your instrument cannot
set temperature but can read it, then this will be greyed out. If the instrument is a 4700, then
enter the temperature displayed on the temperature control box.
Â Internal Laser
Are you using the internal laser of the instrument.
Ã Sample Dispersed in water
Is your sample dispersant water?
Ä Concentration
This is an optional parameter, entered for documentary purposes.

5.2.3

Advanced Sample details dialog (size mode)

If you have stated that your dispersant is not water you will be prompted for more information:
Refractive index
Enter the refractive index of the dispersant.
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Viscosity
If your system is nearly aqueous (e.g. contains salt), you may approximate the viscosity with that
of water, otherwise the viscosity must be entered.

5.2.4

Sample Parameters (Zeta Mode)

In zeta mode the dialog will look as follows:

1

ILL 3806

4
3
2

The requested details are as follows:Temperature. This is the temperature at which you wish to perform your experiment. If your
instrument cannot set temperature but can read it, then this will be greyed out. If your instrument
can do neither then enter a temperature determined by some other means.
À Concentration
This is an optional parameter, entered for documentary purposes.
The following a priori information can help optimise your measurement process.
Á Zeta potential negative
Is your system of negative zetapotential ?
Â Zeta potential positive
Is your system of positive zetapotential.?
Ã Zeta potential unknown
Is it completely unknown?

5.2.5

Advanced Sample details dialog (Zeta mode)

If you have indicated that your dispersant is not water you will have to fill out another dialogue
box.
This next dialogue has the following options:
Dielectric constant
Enter the dielectric constant of the dispersant here.
Viscosity
If your system is nearly aqueous (e.g. contains salt), you may approximate the viscosity with that
of water.
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The next dialog in the sequence is as follows.

5.2.6

Measurement details dialog

The dialog looks as follows and is the same in Zeta and Sizing modes.

1
2

ILL 3807

3

The parameters are as follows:
À Number of measurements
Number of measurements in the sequence
Á Delay between measurement
Delay (Hours, Minutes, Seconds)s
Â Measurement duration
Rapid - Use a relatively short measurement duration (2min in Size mode, 20s in Zeta mode.
Automatic - Use the standard auto-duration procedure to determine the measurement duration.

5.2.7

Post measurement details dialog

This is the last dialog in Wizard sequence. It has the following appearance:
1

3

ILL 3809

2

À Save to disk
Save each measurement to the current file (as well as the Live Records buffer)
Á Print result
Print a report for each measurement.
Â Browse
Gives the user the option to change the file to which measurements are saved.
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End
Ends the setup procedure without starting a measurement.
Run
Ends the setup procedure and starts a measurement.

5.3

Measure - Document

This command
allows information concerning the sample and sample preparation to be
attached to a measurement along with any relevant experimental parameters. This information
is stored with the result and can be saved to file or re-loaded along with the result information.

5.3.1

Measure - Document (Size mode)

When the Measure - Document menu item is selected the following dialogue appears. The key
features of the dialogue are identified and explained.

1

5
6

3 2

ILL 3811

4

7

À Set Temperature
This is the temperature at which you wish to perform the experiment. If your instrument can only
read temperature this will be greyed out.
Á Read Temperature
This is the temperature of the size cell as read back from the instrument.
Â RI dispersant
This is the refractive index of the dispersant. This is for information purposes only and so is
greyed out.
Ã Wavelength (size mode only)
This is the default wavelength of the laser.
Note: If you are using an external laser its correct wavelength must
be given.
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Ä Real. Ref. Index. (size mode only)
This is the refractive index of your sample.
Å Absorbance (size mode only)
This is the absorbance of your sample.
Æ Advanced (size mode only)
Certain settings regarded as advanced are accessed by clicking the “Advanced” button. These
parameters are as follows:
Mark Houwinck A, K .
These are for estimating the molecular weight of your sample. This method of determining
molecular weight is not intended to replace standard static light scattering methods and should
be used with care.
The following parameters are relevant if you wish to use a shell model of your particles. A shell
model assumes that your particles can be modeled as a sphere of one refractive index coated
with a shell of another refractive index. If the refractive indices of the shell and core are the same,
the model is identical to a sphere of constant refractive index.
Radius ratio
Ratio of inner radius to outer radius. (Always less than one).
Core Real RI
Refractive index of core
Core Image RI
Absorbance of the core.
Setup measurement
For convenience a button giving access to the Setup measurement dialog has been provided.
Select Sample
Also for convenience a button is provided that allows you to setup a sample database.

5.3.2

Measure - Document (Zeta mode)

When the Measure - Document menu item is selected the following dialogue appears. The key
features of the dialogue are identified and explained.
1

34 5

9
10

67 8
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À Title
Three lines of text are available to describe the sample. If the first characters are numeric, then
these can be used as a plot parameter using the user defined plot function.
Á Source
The origin of the plot currently displayed on screen.
Â Set Temp
The requested temperature. The default is 25oC
Ã Read Temperature
The actual measured temperature.
Ä RI dispersant
This parameter is “greyed out” as its value is not required for result calculation.
Å Viscosity
The viscosity of the dispersant. This is automatically calculated from the temperature for aqueous
systems. If the value is over ridden, the aqueous setting can be reset by entering 0 (Zero)
Æ Dielectric Constant
This is a parameter associated with the dispersing medium. The value of most of the liquids used
for sample dispersion can be found in chemical handbooks.
For water it is automatically calculated from the measured temperature.
For mixtures of dispersant (e.g. ethanol/water), if no method of measurement is available, an
estimate can be made by a linear interpolation between the values of the two separate
dispersants.
Ç Electrode spacing
If it is automatically set, this will be greyed out. For the ZEM011 and ZEM019 this must be entered.
È Cell
The cell type and characteristics are automatically determined.
The number displayed on the right of this box is the measurement position in the cell as a
percentage of the width of the cell.
For the Capillary cell the stationary layer is fixed at 17% from the top of the cell.
For the Aqueous and non aqueous “dip in” cells there is no stationary layer, therefore the laser
beam passes halfway through the electrodes (50%).
É F(Ka) value
This is a reminder of the value that will be used in the calculation of zeta potential at the end of
the measurement.
It can be changed under the menu item setup-analysis.

5 Set up Measure

Fast access to instrument set up.

6 Select sample

A list of sample types with pre-set parameters for rapid set up.
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5.3.3

Measure - Document (Intensity mode)

When the Measure - Document menu item is selected the following dialogue appears. The key
features of the dialogue are identified and explained.
3

1
2
7
8

4

10

ILL 3877

9

6 4

À Title
Three lines of text are available to describe the sample. If the first characters are numeric, then
these can be used as a plot parameter using the user defined plot function.
Á Source
The origin of the plot currently displayed on screen.
Â Standard RI
The refractive index of the scattering standard used to calibrate the laser power. A pure liquid
like toluene is often used.
Ã RI dispersant
This is the refractive index of the dispersant.
Ä Wavelength (size mode only)
This is the default wavelength of the laser.
Å Dn/Dc
The rate of change of the refractive index with concentration in litres per gram. This is a parameter
that has to be known accurately to obtain an accurate molecular weight. The value is squared
in the final calculation. The value is specific to a particular material dissolved in a particular
solvent.
Æ Raleigh ratio
The scattering ratio for the standard used to calibrate the laser power. Obtained from literature
values.
Note: Some older literature values are known to be wrong. It is
advisable to obtain a Raleigh ratio from two independent sources to
confirm the value of the wavelength being used.
Ç Concentration
The sample concentration in grams per litre for each of the samples used for a Zimm or Berry
plot.
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È Set up Measure
Fast access to instrument set up.
É Select sample
A list of sample types with pre-set parameters for rapid set up.

5.4

Measure - Inspect

This brings up the live display of the correlator
as a separate window. This window can be
moved and resized. This window essentially is the correlator control panel and carries all controls
needed to configure the correlator for manual control. Direct control of the correlator is
recommended only for experienced users, since the automatic routines used in the standard
measurement sequence have been designed to use the facilities in an optimal way. The user
should be aware that under the display menu item the user has the choice of displaying the live
display or a rate meter. For routine use the user may prefer to always display the ratemeter rather
than the correlation function, which is generally useful for diagnostic purposes.
To display the ratemeter select Display - Ratemeter from within the Correlator display window
when the correlator has been controlled directly and a calculation is subsequently required.
During a normal measurement this function is applied automatically.
During a measurement sequence the menu is reduced to carry only Stop and display. Stop will
abort the sequence.

ILL 3812

The live display is always on screen. The appearance of the window is as follows:-

5.5

Measure - Transfer

This command copies data from the correlator, combines it with user entered parameters and
performs an analysis of the selected type. The record is added to the live records buffer and
plotted on screen. It is only required when the correlator has been controlled directly and a
calculation is subsequently required. During normal measurement this function is applied
automatically.

5.6

Measure - Start Sequence

This command
starts the sequence of measurements defined in Setup Measurement, or
by using the Measurement Wizard. The sequence consists of configuring the correlator, taking
some data, analysing it, and optionally saving it to a named file.
In intensity mode, if the instrument connected is a spectrometer there will be a floating menu
allowing you to perform different intensity scan measurements. If the instrument is not a
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spectrometer then Time trace will be carried out by starting sequence. Otherwise there will be
three other options:
Zimm Scan
Debye Scan
Angle Scan
For details concerning the setup of these measurements, see chapter 8.

5.7

Measure - Abort Sequence

This will halt any measurement sequence in progress

.

Note: In Zeta potential mode, the measurements can only be aborted
during the “Accumulating Data” period of the sequence.

5.8

Measure - Start Zeta Optics

This configures the optics of the Zetasizer instrument to measure for Size or Zeta experiments.
In Zeta mode the cell and modulator are turned on, making a high pitched “buzzing” noise. This
facility is only useful if you are intending to perform manual Zeta potential measurements,
recommended only for experienced users.

5.9

Measure - Stop Zeta Optics

In Zeta mode the cell and modulator are turned off. A transfer will also have the same effect.
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6.1

MAN 0160

Introduction to the View menu

The View menu allows you to change the way the data is displayed by giving you a list of standard
views. Changing the View will only change the way the data is displayed - it will not change any
of the data values.

ILL 3792

The information you have generated by analysing the measurement data is displayed on the
screen. The data can be displayed in various formats - each format is known as a view. Malvern
provides 11 standard views that can be quickly selected by opening the View menu. The View
menu is shown below.

6.2

View - Live

This menu
calls up a dialogue which displays the contents of the Live Records buffer in a
list box. Some records will be highlighted following a measurement sequence. The user can
modify any selection and perform actions on these selected records summarised on a set of
control buttons.
The buttons are different according to the mode of the software, but are summarised below.
Close
Closes the dialog having changed the record selection.
Edit...
View and perhaps modify the parameters associated with a record.
Save
Saves selected records to the currently open file.
Save As…
Prompts the user for a filename, and saves the currently selected records to this file.
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Print
Displays the print dialog Box to allow printing of the selected records.
Add plot
Plots the the contents of the selected records in the style and selection currently set for the
existing plot without clearing it. Clicking with the right mouse button will give a popup menu
identical to the one normally display from the View Add Plot popup menu (see below) allowing
the user to plot in the style of his choice.
New Plot
As for Add plot except that the axes are cleared.
Analyse
Re-analyse the selected records. clicking activates the setup analysis dialog.
Delete
Allows the user to delete unwanted records. The user is prompted to confirm that he really does
want the records removed.

6.3

View - New Plot

Prompts for the user to select a type of data to be plotted, then acts like the New Plot button
under View Live, clearing the plot area and plotting of the chosen data from the selected records.

ILL 3839

The list given below is for SIZE data.

Intensity, Volume, Number
These three plots are all different ways of interpreting the amplitude of the particle size
distribution. (see PCS light scattering applications manual).
Residuals
The Difference between Fit and Data indicating the quality with which the result matches the
data.
Fit
Selects the correlation points back-calculated from the result. These points are plotted on the
same axes as the data. The data points are Derived from the actual data in the correlation function
by selecting a sub-set of points usually geometrically spaced and normalising these by dividing
by the baseline.
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Correlogram
The whole of the correlator channel contents not sub-selected or normalised.
Diffusion
Plots the X-axis as diffusion coefficient rather than Size.
Relaxation time
Plot the X -axis as time rather than Size.
Molecular weight
Interprets the diffusion coefficient distribution as a molecular weight distribution using further user
supplied parameters. See also Mark-Houwinck relationship.
User Log Plot
A log plot using the variables selected under the Setup user log plot dialog is created using the
currently selected records.

ILL 3840

In the case of Zeta Potential the options are:

Zeta Potential
The X axis of the plot is Zeta potential Y axis normalised intensity.
Mobility
The X axis is Electrophoretic mobility. This is the directly measured quantity that zeta potential
is derived from.
Frequency
The fast fourier transform (FFT) of the correlation function plotted over the range used in the Zeta
Potential calculation. In effect Mobility multiplied by electric field and divided by the fringe spacing.

Raw frequency
The FFT of the correlogram plotted over the range from 0 to the upper frequency set by the
sample time of the correlator.
Fringe Model
The Correlogram with the ‘beam profile’ removed by a polynomial fit, revealing the higher
frequency fringe transit data that is further processed by the FFT to yield the frequency spectrum
and hence the mobility distribution.
User Log Plot
A log plot using the variables selected under the Setup user log plot dialog is created using the
currently selected records.
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In the case of Intensity:
Intensity mode for an instrument that has a fixed angle, timetrace will be the only option.
Otherwise, the following will be available:
Time trace.
Intensity vs Angle.
Intensity vs K2.
For the 4700 spectrometer the following plots are also available:
Guinier plot.
Zimm plot.
Debye plot.

6.4

View - Add plot

As above but does not first clear the plot area. In the case of the user log plot the existing log
plot is replotted.

6.5

View - Log table

Replaces the Table area by a list of the short form results for a set of selected records, and
quotes statistics on the tabulated values. Amongst the values tabulated are the count rate, z
Average size and polydispersity.

6.6

View - User log table

A Table log of the current log data is displayed in the Table area. The display can be customised
using the Setup - User Log Table dialog. This option is not available in intensity mode.

6.7

View - Sample summary

Puts a summary of experimental parameters in the table area.

6.8

View graph / View table

The relevant sub area (or ‘pane’) of the current window is expanded horizontally so that the whole
window area is used for that display function. These commands are included so that they can
be recorded and assigned to ‘easy buttons’. They also facilitate screen control from the keyboard.
The graph and table can also be made to fill the screen by double clicking on it. Double clicking
again restores the split screen.

6.9

View - Split screen

Each time this menu item is selected the proportion of ‘Graph’ to ‘Table’ area is increased by
20%. This function is primarily intended for keyboard control, when ‘pulling’ the divider bar will
be difficult to achieve. If the Graph area is already full screen, use View Table area followed by
one or more applications of Split Screen to adjust the view.
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View - Cursor

A small display that gives a readout of the mouse position as X - Y plot values in the graph area.
The readout is updated when the RIGHT MOUSE BUTTON is pressed, and the mouse pointer
moved over the graph. This function is an on/off toggle. Cursor is ticked when on.

6.11

View - Zoom / Unzoom

When ZOOM is selected a ‘Rubber rectangle’ can be inscribed in the plot area by holding the
LEFT MOUSE BUTTON down while moving the mouse in the plot area. This area will be
expanded when the button is released. UNZOOM reverts to the full size display.

6.12

View - X Expand / Y Expand

The appropriate Graph axis is expanded to the next ‘stop’. The process can be reversed by
pressing UNZOOM. This feature is provided particularly so that Easy Buttons to perform this
function can be recorded.

6.13

View - New art object

Allows the user to add an art object, to the graph area which could be a line, rectangle, text, text
in a box or a bitmap. After selecting “new art object”, a rectangle can be drawn on the graph by
holding down the left mouse button and moving the mouse. Releasing the button when the
desired rectangle has been drawn. An Art properties dialog will be displayed giving the user the
opportunity to change the objects properties (i.e. whether a rectangle, text, line, bitmap, and its
colours etc.). Double clicking on an existing object will bring up this dialog. Depressing the left
mouse button in the interior of an object allows the user to move the objects position, whilst
depressing the move button just outside the object ‘s bounding rectangle allows the user to resize
it.

ILL 3813

The dialog used to add or edit individual ‘clipart’ items is shown below.

6.14

View - Status bar

Enables or disables the display of the Status bar. The Status bar consists of two panes, the left
displays general information, such measurement status, or help on selected menus, the right
displays specific instrument information.

6.15

View - Tool bar

Enables of disables the tool bar. To customise the tool bar see Setup ToolBar.
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6.16

View - DDE Links

This command shows a list of the currently active Dynamic Data Exchange (DDE) conversations.
The information shown is:
l

The PCS status in the link - server (source) or client (destination).

l

The name of the partner (for example ‘Excel’)

l

The type of link - hot (automatic) or warm (advise).

l

The topic and item as defined in the Zetasizer software.

6.17

Related information

For related information on this subject see:
Edit-Copy Link
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7.1

MAN 0160

Introduction to the Control menu

The Control menu contains commands that allow you to run and control Malvern Basic programs
and to control the instrument from remote locations. Using the commands within this menu allows
you to:
l

Run a Malvern Basic program.

l

Edit a Malvern Basic program.

l

Assign a Malvern Basic program to the control menu or to a function key.

l

Change the Easy buttons.

l

Control the instrument from a remote location.

ILL 3793

The Control menu is shown below.

Each of the menu items are now described in detail.

7.2

Control - Run Program

This command runs a Malvern PCS Basic program. The program may be produced by using the
program editor.
When the Run Program menu item is selected the following dialogue appears. The key features
of the dialogue are identified and explained.

1

ILL 3814

2
3

Page 7.1
Artisan Scientific - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisan-scientific.com

MAN0160

À Run
The Run button will run the currently selected program when pressed. The program currently
selected is named to the left of the run button. The button is disabled if no program name is
currently set - the label reads ... in which case the user should select a program from the list
box.
Á Exclusive
The Exclusive checkbox is set if you want the program to run without being interrupted. The
program will not be terminated by the Stop menu item or button but will respond to the Cancel
button in Print Dialog or InputBox$ dialogue boxes.
Â Display Warnings
Set this checkbox if you want any errors to produce a warning message box in the same way as
the equivalent menu command would do. If this checkbox is clear then errors are reported using
the Error Basic variable. In this way full unattended operation is possible.

7.3

Control - Edit Program

The Edit Program command is used to edit a Malvern Basic control program.
The program editing window appears which allows programs to be loaded, edited, saved and
run.
See the Malvern Basic manual for details.

7.4

Control - Assign Program

The Assign Program command allows up to 8 Malvern PCS Basic programs to be assigned to
entries in the Control menu and to function keys.
When the Assign Program menu item is selected the following dialogue appears. The key
features of the dialogue are identified and explained.

5

2

4

6

ILL 3815

1

3

À Program Name List
The Program Names List box lists the names of the Basic programs (file extension PCM)
available to assign to the Control menu and function key.
Á 1 to 8 Option buttons
The option buttons shows the index of the program that can be assigned.
Â Auto Run
Select the Auto Run radio button to assign a program which is run when the PCS program is
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started. The configuration must be saved when the PCS program is closed down. For the auto
run program to start when the system is next switched on.
Ã Menu Label
A menu label can be typed in for the assigned program. Use an ampersand (&) before any
character you want to assign as an accelerator key - this should not be a character that is already
used in the Control menu. The function key assignment is automatically added.
Ä Assign
Click the Assign button to assign the program selected in the Program Name
List to the chosen function key.
Å Program Name
The Program Name list show the names of the programs assigned to the function keys and
Control menu.

7.4.1

How to use the “Assign Program to Menu” dialogue.

To assign a program to a function key:
l
l
l
l
l

Select a program from the Program Name List.
Select one of the option buttons according to the function key combination (F5, F6 ..., Alt +
F8) which you wish to use.
Select Assign. The program name will appear in the box next to the selected button within
the Program Name list.
Enter a Menu Label to appear in the Control menu. The function key assignment is
automatically added.
Select OK.

To remove an assigned program:
l

Delete the name from the appropriate Program Name box.

l

Delete the Menu Label to avoid confusion.

l

Select OK.

To assign a program to run at startup:
l

Select a program from the Program Name List.

l

Select the Auto Run option.

l

Select Assign. The program name will appear in the box next to the Auto Run button.

l

Select OK. The configuration must be saved when the Zetasizer is closed down. The Auto
Run program will run when the Zetasizer program is next started.
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7.5

Control - Buttons

The Buttons menu item allows the Easy - or toolbar - buttons that can be changed.
In the configuration originally supplied, the selection defines a range of operations which are
frequently performed in making a measurement and analysis.
When the Easy Button menu item is selected the following dialogue appears. The key features
of the dialogue are identified and explained.
À Buttons List (on right)
The Button List shows a representation of the buttons as they appear below the menu bar. Up
to eighteen buttons are available. Select the button to be changed.
Á Button can be bitmap
The Available Buttons list box lists all available buttons. Each button is a Windows bitmap (file
extension BMP).
Â Status Line Message
After selecting a button on the right, the Status Line Message edit box allows you to type in the
message that will appear in the status line as the mouse cursor is moved over the button. By
default this is the same message used by the assigned menu item.
Ã Tool Tip Message
The Tool Tip message edit box allows you to type in a message that will appear in the tool tip
which appears when the mouse pointer is held over a button.
Ä Add Button
Select Add Button to add a selection from the button bitmaps to the end of the Button List.
Å Remove Button
Select Remove Button to remove a button from the current tool bar configuration.
Insert
Insert places the selected button bitmap at the previous point selected.
Æ Change button
Select Change Button to change the button in the Button List with the selection in Button bitmaps..
To program the buttons, exit the dialogue and click with the right mouse button on the button or
icon you wish to re-program. You will be asked if you intend to continue. If you choose to proceed,
the first left mouse button click on a menu will associate that menu with the button. Further left
mouse clicks will then program a menu item to the button so that, for example, “View”, “New
Plot”, “Volume” is programmed to the button and can be displayed with a single press of the
button.
Ç Sampler
An Autosampler may be attached to the system and the autosamper software installed. The
normal type allows a tray of up to 70 samples to be present at one time, with a motorised syringe
that can take up sample from any position, carry it to the injection port and transfer it to a tube
that will carry it to the measurement cell. The scheduler is a separate Windows task that operates
by requesting that a certain program be run by the PCS program. This program will include the
commands needed to operate the autosampler directly, associated with others to perform a
sample measurement.
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The Sampler ‘set up’ dialogue allows a program to be logically associated with each separate
sample station, and invoked by a button located in the same X-Y position on the display, as the
sample occupies in the rack. Samples can also be designated as priority samples to be analysed
first. The program for each sample can be identical (set as a default). Normally the default simply
executes a measurement as designated in the Setup Measurement dialogue.
The built in program editor is used to create and amend the autosampler files, which have the
.ASF extension to distinguish them from other types. Some built in program commands facilitate
control of the autosampler, and are used in the programs to control the autosampler. One widely
used autosampler command asm, fil, filename simply downloads an autosampler control file to
the sampler and causes it to run. Predefined files are set up to flush out old samples, carry out
predilution sequences, and other ‘housekeeping’ roles.

7.6

Control - Remote

Use this command to place the instrument under remote control. In this mode all control of the
instrument is transferred to a remote device sending commands via an RS232 port.
The only active control is the menu item Stop which breaks the remote control and restores full
control from menu commands, buttons and keys.
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8.1
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Introduction to the Setup menu

The Setup menu contains the commands that allow you to setup and configure your software.
The commands within this menu allow you to:
l

Setup a measurement sequence.

l

Modify the appearances of graphs

l

Modify your data analysis process

l

Control external hardware

ILL 3794

The Setup menu is shown below.

8.2

Setup - Graph

This item gives rise to a further sub-menu with a list of preferences for displays that are available
for them to be selected to the Context (In the case of a size window the choices are shown below.
Operation in other contexts is very similar).
The available preference options are Size, Diffusion coefficient, Relaxation time, Molecular
weight (all these have sub sets of intensity/volume/number which are handled by this one choice),
Fit , Residuals and Correlogram (the choices for a zeta potential window are somewhat different,
but are handled in a similar fashion). The form of the dialogue is identical in each case. The user
can select the X and Y axis to autoscale or be preset with Log or Linear scaling. The plot style
can be graph or histogram with or without a colour fill. The colour use sequence is automatically
selected. Fonts used for the Graph axes, and the background colour for the display can also be
altered. Font height is expressed in tenths of a millimetre. When a Font is selected a size must
be specified.
When the preference for the current plot is changed it will be updated in accordance with the
new settings.
These settings are independent for each type of plot in each context. The dialogue can also be
invoked by clicking the mouse RIGHT BUTTON with the pointer immediately below the graph x
axis.

Page 8.1
Artisan Scientific - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisan-scientific.com

MAN0160

8.3

Setup - Measurement

Operating this control
brings up a dialogue that enables the user to customise the
measurement process. The controls provided vary in detail between size, zeta potential and
intensity.

8.3.1

Size mode

In Size mode the measurement dialog appears as follows.
3

1

8
7
2
9

4

ILL 3816

6

5

À Number of measurements
The number of measurements to be performed in a sequence
Á Measurement duration
If Auto is specified the system will determine a duration based on the current count rate.
Â Sample time selection
If Auto is selected , the system will determine correlator a sample time. Other wise the sample
time will be based on the estimated size specified. Note that these options are not applicable for
the 70128 and the 7132 correlators.
Ã Delay between measurements
User defined delay between measurements.
Ä Advanced
The advanced button brings up a dialog of advanced options concerning automatic changes of
angle, cell position, temperature etc.
Å Inspect live signal
The inspect check box enables or disables the view during a measurement of the accumulating
correlation function. If not checked the correlation function will remain an icon.
Æ Analysis
The Analysis change control performs similarly to Setup Analysis as detailed below.
Ç Save on disc
Saves each result using the report specified under options.
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È Printing
Prints each result using the report specified under options.

8.3.2

Zeta mode
3 1

2

9
10

8
7

5

6
ILL 3841

4

À Number of measurements
The number of measurements to be performed in a sequence.
Á Measurement duration
If Auto is specified the system will determine a duration based on the current count rate.
Â Sample time selection
If Auto is selected , the system will determine a sample time. Other wise the sample time will be
based on the estimated size specified. Note that these options are not applicable for the 70128
and the 7132 correlators.
Ã Delay between measurements
User defined delay between measurements.
Ä Zero field correction
Performs zero field measurement to allow subtraction of the effects of Brownian motion from the
measurement.
Å Sign of Zeta potential
Optomises the measurement sequence for measuring positive or negative particles.
Æ Advanced
The advanced button brings up a dialog of advanced options concerning automatic changes of
angle, cell position etc.
Ç Inspect live signal
The inspect check box enables or disables the view during a measurement of the accumulating
correlation function. If not checked the correlation function will remain an icon.
È Save on disc
Saves each result using the report specified under options.
É Printing
Prints each result using the report specified under options.
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8.3.3

Intensity mode

With an instrument that does not have a selection of angle, the setup time trace dialog will look
like this:

1
2

ILL 3853

3
4

À Number of angles
The number of measurements to be performed in a sequence.
Á Angle
Angle at which the timetrace measurement is carried out.
Â Sub scans/angle - Duration/angle
Each measurement consists of measuring the average intensity over a short duration.
The angle and Zimm scan measurement dialogs are identical. The only difference is that a start
and an end angle must be supplied.
Ã Inspect
This enables a live display of the correlator during a measurement.

8.4

Setup - Analysis

This control brings up a dialogue that allows the user to change the type of analysis being
performed. The detail depends on context:

8.4.1

Size mode

ILL 4333

For the purposes of illustration we use the example of Size. Options are Cumulant (monomodal),
Exponential sampling (multimodal), Contin, Multi angle, and Standard. Multi-Angle is available
as an extra option which may, therefore, not be available on a particular installation.
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The analysis options all have features not normally of interest to the routine user. These are
classified as ‘advanced À’. The dialog for Monomodal is shown below.

6

2

5

3

4

ILL 3819

1

7

À Dilation
Chooses the logarithmic spacing between points. If 1.0 is used all points are selected.
Á First Point
First point used by the analysis.
Â Number of Points
Number of points used by analysis.
Ã Cutoff
Points are selected by cutoff, that is points are used until a given threshold is reached.
Ä Auto-select
Selects the first point automatically.
Å The order of fit
It is normally set to 3 when a mean size is derived, together with an estimate of “Polydispersity”
(the width of the distribution).
Æ Point weighting
Quartic weighting is the currently accepted weighting to use for this analysis. For compatibility
with DOS software versions, Quadratic can be used.
All the other types of analysis need the user to determine what size class range he intends to
use. The user can select auto range, or specify the range of particle size explicitly or in terms
of a fixed range (upper size/lower size). The auto selection is usually provides a good starting
point. Overriding the auto selection to set a fixed range can be useful if the user wishes to ‘home
in’ on a particular region. This can be risky as the multimodal analysis, in particular, can give
unreliable results if an inappropriate range for a particular correlation function is chosen.

8.4.2

Zeta mode

ILL 3818

For zeta measurements the dialog is shown below.
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In the context of a zeta potential measurement the analysis options are limited. The order of fit
of the polynomial that models the behavior of the ‘background’ part of the correlation function
can be altered from the default value of 5. It may be reduced to 1 or 2 if the correlator has been
so set that either very many or very few fringes are present in the time window. This will generally
only occur if the correlator is being set manually rather than using the automatic controls, for the
experienced user only.
The other way in which the user can affect the analysis is by over-riding the choice of model for
conversion of mobility to zeta potential. Normally the Smoluchowsky relationship is used for
ZET5104 cell, the Huckel for the the ZET5126. The user can enter instead an explicit value for
f(ka), derived from a more sophisticated mathematical analysis of the double-layer around the
particle surface. This is only normally going to be useful for smallish particles in rather dilute salt
concentrations, or very high zeta potentials.

8.5

Setup - Tables

ILL 3820

This control calls up a dialogue which enables the user to associate a page program to be
displayed in the right hand page instead of the default table. The dialogue is shown below.

In the example shown above the program SSUM.PCP has been assigned to the plot function
sample summary. The X in the box alongside will cause the program to be used for this function
when sample summary is next displayed, or immediately if it forms the current plot option.
To assign a program, select it from the list, select a function to associate it with, and press assign.
Page programs are very like control programs, but have a file extension of .PCP to distinguish
them. The Fonts used in the programs, symbolised 1 - 4 , can be associated with particular
system fonts using the Font control. The program is written or amended with the Editor, and can
be run for trials purposes from the editor. Once correct, it must be saved and assigned to some
page update function.
The table set up dialogue can also be invoked by pointing the mouse into the table area and
clicking the RIGHT BUTTON.

8.6

Setup - Key

A dialogue enabling the user to select the items that he wishes to display in graph key window
and how they should appear. This dialog can also be invoked by clicking the RIGHT BUTTON
with the mouse pointer in the key area. The dialogue is shown below.
The dialog appears as follows.
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Setup menu

Note that the available check boxes will be different according to the measurement mode. For
example in Zeta mode, all Size options will be greyed out.

8.7

Setup - Report

This command invokes a dialogue which enables the user to set up a one or two page report,
each page being assigned to a different Page Program. The Page program can be one of a set
of Malvern supplied report styles, or a custom page designed by the user in the ‘page
programming’ language. This is discussed in detail in chapter 3. It may also be printed
automatically after a measurement, or from the View-Live, or File-Records dialogue box.

8.8

Setup - User log table

A dialog that enables the user to define his own log table for the table area. Log data is created
by running a measurement sequence or plotting a new user log plot after selecting data from a
file or the live buffer. The can be viewed by selecting the menu item View User Log table
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A dialog that enables the user to define his own log table for the table area. Log data is created
by running a measurement sequence or plotting a new user log plot after selecting data from a
file or the live buffer. The can be viewed by selecting the menu item View User Log table

A series of check boxes is used to identify parameters to be included in the ‘user log table’, and
a ‘field’ parameter controls the width (in characters) of the resulting column of the table.
A typical user log table is shown below:
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Rec. Date

8.9

Counts

ZAve

Poly

Angle

1

07:04:96

326902.0

72.7

0.0786

90.0

2

07:04:96

328334.0

72.3

0.1158

90.0

3

07:04:96

324572.0

72.1

0.1235

90.0

4

07:04:96

327289.0

72.6

0.1808

90.0

5

07:04:96

332731.0

75.2

0.1765

90.0

6

07:04:96

338307.0

76.3

0.1769

90.0

7

07:04:96

339018.0

78.2

0.1891

90.0

Setup - User log plot

A dialog enabling the user to define what variables he wishes to be displayed in the user log
plot. This is created by selecting View-New Plot-User logged plot or running a measurement
sequence.

ILL 3823

Below the dialog used to select the parameter for each axis of the plot.

If the user wishes to plot quantities measured in different modes (e.g. size against mobility) then
a similar number of records should be selected from a live buffer. The software automatically
matches data extracted from each source on a record by record basis to produce the composite
plot.

8.10

Setup - Instrument

This sub menu is normally ‘greyed out’ as the functions provided are not normal user operations.
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Calibrate pH
This brings up a dialogue in which a live display of the pH meter reading is displayed and the
user given the opportunity to Cancel or proceed to calibrate the probe.
To calibrate the probe the user must inject (or externally dip the probe into) a buffer solution, first
of pH about 4, then about 9. A pause of 5 minutes is then recommended to give time for
stabilisation of of the pH before a calibration reading is taken. For a more accurate calibration a
longer stabilisation time is recommended. The actual values of pH are entered and in each case
a number of readings over a 10 second period are averaged. (see also Zeta applications manual).

8.11

Setup - RS232

Brigs up popup menu:

ILL 3842

Connect Autosampler

Allows the connection/disconnection of the optics unit, as well as the RS232 configuration e.g.
using COM1 to connect to the Zetasizer.
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Introduction to the Help menu

Context sensitive help, using shift F1, is available for all toolbar buttons and menu items.

ILL 4336

The Help menu contains the commands that allow you to use the on - line help. The Help menu
is shown below.

Each of the menu items are now described in detail.

9.2

Help - Menu items

Ill 4334

Selecting this item takes you to the main contents of the Zetasizer Help system.

More information on using the help can be found in Chapter 1.

9.3

Help - BASIC Commands

Selecting this item takes you to the PCS Help topic on Zetasizer Basic commands.

9.4

Help - Using Help

Selecting this item gives you help on using the Help system.

9.5

Help - About

Selecting this item shows you the About box. As well as showing the program name this box
informs you of the instrument type and software version number.
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The box also tells you if the instrument is connected, if an arithmetic co-processor is installed
and notes the amount of memory free.
If the memory shown is small compared with the amount of memory installed on your system,
you may have a number of other programs loaded. The response of the system may be slow
and there may be considerable disc activity as you switch between applications. You might
consider closing down some of the applications.
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The filing system

The main directory \PCS contains the main program file and a number of other files needed to
run the system.

10.2

File names

A file is the basic unit of storage on the disc. Files are distinguished by their names which consist
of a stem of up to 8 characters followed by an optional 3 character extension. Windows uses the
DOS filename conventions. The extension is often used to emphasise the type of file, for example
.SZ2 to indicate a file of sizes.
The DOS filename convention states that a name must start with a letter or a number and cannot
contain any of the following characters:
Character Character name
.

Period

“

Quotation

/

Slash

\

Backslash

()

Brackets

:

Colon

|

Vertical bar

=

Equals

,

Comma

The following cannot be used as names:
CON, AUX, COM1, COM2, COM3, COM4, LPT1, LPT2, LPT3, PRN and NUL.

10.3

Wild cards

A wild card is a character which represents other characters.
In file names the character * represents any character or characters which might match that
position in other filenames. For example *.SZ2 represents all filenames which end in the
extension .SZ2. This would find the files MYDATA.SZ2, MYDAT.SZ2, ANOTHER.SZ2, etc. if
they exist.
The character ? represents a single character which might match that position. For example
MYDATA?.SZ2 would find files MYDATA1.SZ2, MYDATA2.SZ2, etc. but not MYDATA12.SZ2
or MYDATA.SZ2.

10.4

File extension

The file extension can consist of 1, 2 or 3 characters or be omitted completely. If no extension
is given some applications may need the final period (.) in order to recognise the file.
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Some file extensions are used to indicate special types of files. For example the extension .SZ2
is used by Malvern for sample record files, the extension .BMP refers to a Windows Bitmap file.
Such special extensions are used to present you with appropriate file choices when loading and
saving files.
The following extensions are used in the Mastersizer software:
File extension

Description

.PCM

A Malvern PCS Basic program.

.BMP

A bitmap or button image.

.INI

An initialisation or configuration file.

.PCP

A page description file.

.SZ2

A size sample file.

.ZET

A zeta sample file.

.INT

A intensity sample file.

.WMF

A Windows Metafile or picture.

Of these the .PCM, .INI, .PCP files are ASCII text files. The others have special formats and
cannot be viewed or edited using Notepad or other simple text editors.
In particular, the format of the Malvern .SZ2, .ZET, .INT sample files are random access.
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Introduction

The Zetasizer software supports various standard methods for linking data to other programs.
The other application is normally a spreadsheet, data gathering program or document
preparation program (word processing). For clarity the examples within this chapter will refer to
linking to Microsoft Excel. Certain items will, therefore, be specific to this use. To use another
software packages you will need to refer to the manuals for that software.
Items can be transferred to other applications in a number of ways - as a simple, once only, copy
and paste, as a link which is updated on request or as an automatic (hot) link which is updated
every time the item changes.

11.2

The Windows clipboard

The simplest transfer of information uses the Windows clipboard - commonly called “copy” and
“paste”. All the Zetasizer commands that communicate with the clipboard can be found on the
Edit menu. See chapter 4 for more information.
Use the Windows program Clipboard Viewer (called Clipbook Viewer in Windows for
Workgroups) to preview any items copied to the clipboard. The clipboard viewer program is
usually found in the ‘Main’ group in Program Manager.

11.2.1

Copying a graph

Select the Edit-Copy-Graph command to copy the current graph to the clipboard. The graph
must be in view in the Zetasizer window before being copied. The graph is copied in both bitmap
and picture (metafile) formats.
In the application that is to receive the image of the graph select from the Edit menu Paste item.
If the image is pasted into an application such as Microsoft Word you can double-click on the
image and edit it using the built-in graphics editor - Draw. This will allow you to change the colours
of the curves, change the fill styles or text sizes etc.

11.2.2

Copying the table

Select the Edit-Copy-Table command to copy the current table to the clipboard. The table does
not need to be in view in the Zetasizer window before being copied. The table is copied in picture
(metafile) format, if the as picture option is used, or as text if the as text option is used.
In the application that is to receive the image of the table select from the Edit menu the Paste
item. The pasted table should then be re-sized so that the text is readable and the columns do
not run into each other if the picture format is used.
If the image is pasted into an application such as Microsoft Word you can double-click on the
image and edit it using the built-in graphics editor - Draw. This will allow you to change the colours
of the blocks, change the font styles or sizes, remove unwanted sections of information, etc.
If the image is copied as text and pasted into an application like Exel, the text is inserted as a
table which can be edited in the normal manner, cell by cell.
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11.2.3

Copying the whole window

You can copy the whole of the Zetasizer window using the standard windows key sequence of
holding down the Alt key and press the Print Screen key. The current window is then copied to
the clipboard as a bitmap. Use the same operation to copy any of Zetasizer’s own windows or
dialogue boxes.

11.2.4

Copying from the program language

Commands are available in the Zetasizer Basic language to copy graphs, tables, sizes, results
and data. In addition a user defined string of text may be copied. See Copy String in the Malvern
Basic manual for more information. The Print String command is used to build the string which
can contain values from internal functions and expressions. For example you could copy the
percentile points or the derived diameters

11.3
11.3.1

Dynamic Data Exchange
Basic concepts

Dynamic Data Exchange (DDE) is a protocol which allows applications to exchange data on a
real time basis. To perform such exchange, the two participating applications first have to engage
in a DDE conversation. The application which initiates the conversation is known as the client
application, and the application responding to the client is known as the server. A given
application can be engaged in several conversations at the same time and can act as the client
in some of them and as the server in others.
Information transferred between applications using DDE can be formatted in a number of ways.
Some applications may not support all of the formats available.
DDE uses the three-level hierarchy application, topic, item to identify a unit of data uniquely.
Application is the name of the DDE server. Item is a data object which can be passed in a DDE
data exchange. Topic defines the subject of the conversation.
After a conversation has started the client application interacts with the server by issuing
transactions. When issuing a transaction, the client asks the server to perform a given action.
There are six types of transactions: request, advise, unadvise (hot / warm links), poke, execute
and terminate. These are permitted only within an initiated conversation. DDE conversations are
one-way. The client application is always the one which issues the transactions. If the server
wants to issue a transaction to the client, the server is expected to initiate a new conversation
for that purpose. The server becomes the client in the new conversation. (The only exception to
the one way rule is the terminate transaction, which can be issued by either the client or the
server).

11.3.2

Zetasizer and DDE

DDE allows the Zetasizer to communicate with other Windows applications. This can either be
in the form of a single communication or an on-going conversation in which the Zetasizer program
updates another application after each analysis (known as an advise loop, automatic or hot link).
The Zetasizer application can be either client or server. However, certain limitations are imposed
in some situations where it is not appropriate for one or other of the functions. The state of any
DDE links can be displayed using the menu item View -DDE Links.
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Zetasizer server functions

As a server the Zetasizer will respond to DDE on terminate, request, execute and connect.
Sizer topics are:- data, command, system

11.3.3.1

Terminate

If the Zetasizer receives a DDE terminate command the link with the DDE partner on that channel
will be canceled.

11.3.3.2

Request

Zetasizer items for request are ‘prog’ and any Basic system function.
Several special items in conjunction with the topic of “system” will provide, in a DDE request,
information on the Zetasizer’s DDE format, topics and items. Item “Topics” will provide a list of
available topics. Item “Systems” will provide a list of available system items. ‘Formats’ provides
a list of available Zetasizer supported formats. ‘TopicItemList’ will provide a list of supported
system items.

11.3.3.3

Execute

If the Zetasizer receives a DDE execute command it will interpret the data sent as a Basic
command string.

11.3.3.4

Copy Link

When Copy Link is selected from the Edit menu the string “’Malvern PCS’|data!prog” is copied
to the clipboard in TEXT format (the Zetasizer application only understands TEXT format). This
allows any other application with DDE capability to establish an automatic (hot) or manual (warm)
link with the Zetasizer. The topic is always data and the item is always “prog”. In a link of this
type the Zetasizer is always the server application.
Once a link has been established the Zetasizer will tell any partners that are linked in this way
when the data has changed. It is then up to the other application to take the data in a hot link or
request it in a warm link. This is generally done via the Paste Link command from the client’s
Edit menu.
At the end of the analysis in a link of this type a Basic program (by default this is DDELINK.PCM)
is run. It is this program which specifies what data is sent across the link. The way this is done
is by use of a special string only used for DDE. Anything written to this string is used for data via
the DDE.

11.3.4

Zetasizer client functions

As a client the Zetasizer uses the DDE Basic commands to control the conversation. For full
details of the syntax of these commands please see the DDE command in the Malvern Basic
manual. There are four DDE commands available:-
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l

l
l
l

DDE Connect
This command is used to make the initial connection to another application. The Zetasizer
application allows up to 5 conversations at any one time.
DDE Terminate
This command allows the Zetasizer application to terminate a DDE conversation.
DDE Poke
This command allows the Zetasizer program to send data to the server.
DDE Execute
This command is used to send a command to the server.

11.3.5

Example of a Hot Link

A hot link was set up between the Malvern program and Microsoft Excel as follows:l

In Excel select a cell where the information is to be copied.

l

In Zetasizer select Edit.

l

Select Copy Link.

l

In Excel Select Edit.

l

Select Paste Link.

l

In the Zetasizer Software perform an analysis.

When the analysis is complete the spreadsheet will show a column of values.
Performing an analysis on a different set of data will update the link automatically and replace
the items in the selected cells.

11.3.6

Changing the items in the Hot Link

When you use the Zetasizer Copy Link facility this signals that the software should automatically
update the hot link at the end of each analysis. It does this by running a Zetasizer Basic program.
You are able to change both the name and contents of this program.
To select a different program name use the Setup-Messaging... command. In the lowest listbox
you can select the program name. By default, the system will use the program DDELINK.BSC
supplied with your original software.
To change the items in the link you need to understand the contents of this program. The
DDELINK program is shown below. It can also be found in Malvern Basic manual.
‘ Program DDELINK.BSC
‘ To print data to Basic string for use with DDE links.
‘ First make sure string is empty
Delete String
‘ Copy volume array to string
For i = 1 To NumChannels
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Print String Using, “##.#\t##.#\r\n”,sizes(i),intensity ( i )
Next

Link uses a special string to transfer data. It is this string which the program updates. To ensure
that only new information is transferred and not new information added to the end of the old, the
command Delete String is used first. A new string is then constructed. Each item is added to the
string in the format specified. The control characters \r\n are added to produce a CR/LF to
separate the items into a column of cells. The items selected are the elements of the
StoreChannel (i) array which represent the percentage volume in bands as analysed by the
Zetasizer software.
Suppose we want to export only d(v, 0.5) and specific surface area and we want to place them
in the same row. The items needed are the Malvern functions Zavemean (50) and Polydispersity.
The essential parts of the program become:Delete String
Print String, Using, “#####.#####\t”, Zavemean
Print String, Using, “#####.#####\t”, Polydispersity
The control character \t represents a tab and is recognised by Excel to move to the next horizontal
cell.
For further details of the items which you can select to export, consult the list of Malvern functions
in Malvern Basic manual.

11.3.7

Creating a multi-column sheet

Dynamic Data Exchange may be used to create multi-column spreadsheets where each column
contains the result from a single measurement. This arrangement could be used to do automatic
logging of results. (The Zetasizer can also log result directly to a log file on disc or to a remote
computer - see the Setup-Messaging command).
Information can be inserted directly in a spreadsheet cell using the DDE Poke command. First
a link must be started. The following starts a conversation to sheet1 of Excel (which must already
have been started).
DDE Connect, 1, “Excel”, “Sheet1"
Cells can be inserted with labels for the column headings:
Delete String
Print String “Record No.”
X$="R1C1"
DDE Poke, 1, X$

The string “Record No.” is inserted in cell R1C1.
Multiple results can then be loaded into a row of cells. Row 1 has the record number and row 2
has the Zavemean values.
For i=1 to Numrecords
Load Record, i
Delete String
Print String, Using, “#####\r\n”, i
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X$ = “r” + Str$ ( 1 ) + “c” + Str$ ( i + 1 )
Dde Poke, 1, X$
Delete String
Print String, Using, “#####.###\r\n”,Zavemean ( 10 )
X$ = “r” + Str$ ( 2 ) + “c” + Str$ ( i + 1 )
Dde Poke, 1, X$
Next

A complete listing of this program can be found in ‘Creating a Multi-Column Spreadsheet’ in the
Malvern Basic manual.
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Using configuration files

The full configuration of the Zetasizer software is stored in an initialisation file (file extension .INI).
If you close down the software and elect to save changes the current configuration will overwrite
this original file.
You may change this file if you wish. The menu item File-Save Config As... allows you to save
the current configuration to a file of your choice.
Using File-Load Config allows you to load a named configuration file from disc.
The item File-Reset Defaults allows you to recover the Malvern default configuration even if you
have over-written the original configuration file.
All these operations leave the current data and result set unaffected.
These configuration files may be particularly useful if you operate the Zetasizer in a number of
different ways or if it is used by a number of different people. The many choices of hardware and
software settings mean that it is quite easy (and annoying) to find that you have made
measurements with incorrect settings. At worst you may have to repeat the measurements and
even re-printing all the reports with your own choice of formats is time-consuming.
To avoid this make the selection of all parameters which you wish to change and then use
File-Save Config As... to save the whole set-up. Re-loading this configuration will allow you to
be sure that all the settings are restored.
Caution: When you have saved a configuration in this way do not
save the configuration again when you close down or your file will
become the default and may be overwritten by another user.

12.2

Tables and reports

The tables, which are displayed in the right hand pane of the Malvern Zetasizer window and
which are printed, have default values for each graph type displayed. This default can be
overridden using a page program. This is written in Malvern Basic and a different program, to
display graphs or particular result values can be assigned to each graph type. The same language
is used to describe the formats of the single page reports.
A number of these program are provided with your system and these produce the standard
reports usually printed.
You can design your own pages by editing programs yourself. See the Malvern Basic manual
for more information.

12.3

Changing the Easy Buttons toolbar

The buttons in the toolbar below the main menu bar may be changed by the user. This is done
using the Control-Easy Buttons command.
For more information on changing the buttons see in chapter 7.

12.4

Changing the Menus

Only one menu can be changed by the user. This is the Control menu.

Page 12.1
Artisan Scientific - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisan-scientific.com

MAN0160

With the Control menu you can add items to the end of the menu to run user defined Zetasizer
Basic programs. This is done using the Control-Assign Program command. For more
information on assigned programs see chapter 7.

12.5
12.5.1

Changing screen colours and fonts
Graph colours and fonts

The colours used in the graphs may be changed using the Colours button in the Setup-Graph
dialogue.
These colours are also used when the graph is printed, so experiment with the colours to make
sure they appear correctly on your printer.
The Setup-Graph dialogue has a Font button which allows the font used on the graph to be
changed. This font is used on all axis labels and key labels. See the Edit-Graph Plots command
for information on changing the title and key.

12.5.2

Table fonts and background colour

Up to four font types may be used in the tables. These are set by using the Setup Font button
in the Setup-Table dialogue. See chapter 8 for more information. The same fonts are used on
the screen and for printing but the size of the characters may be modified by commands in the
page description programs.
The background colour for the table window is set in the Setup-Table dialogue. This colour is
not used in printing, the printed tables and reports have a white background (assuming you use
white paper).
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Correlator architecture

The software supports the 7032, 70128 and 7132 correlators. The architectures of these
correlators are very different, but never the less the menus and control dialogs are very similar.
For the 7032 Corelator the main menu is as follows:
2

3

ILL 3843

1

For the 7132 and 70128 Correlators the main menu is very similar.
À Start
Starts an experiment
Á Halt
Halts an experiment
Â Clear
Empties contents of the store channels. The 7132 and 70128 correlators do not require a clear
menu as the store channels are cleared at the beginning of every measurement.

A.2

Configure menu

The configure menu allows the settings of the Correlator to customised. As the supported
correlators are quite different we must consider them separately, although it will be seen that
many aspects are quite similar.

A.3
A.3.1

7032 Correlator
Linear mode

A dialogue box is opened that enables the user to select the main operating parameters for
running the correlator in ‘serial mode’ - i.e. with every store channel starting one sample time
later than the preceding one. The dialog is displayed below:
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2

ILL 3849

1

3

À Duration
Selects the duration of an experiment in seconds, and ranges from 10microseconds, to 255*10^8
seconds. The infinity selection as it suggests runs the correlator until it is stopped manually or
by some external trigger.
Á Delay
Allows setting up of a determined delay at which far point channels are located. The units are
in sample times, and delay can be set before or after an continuous set of store channels.
Â Sample Time
User specified sample time.

A.3.2

Log mode

The options in parallel mode are similar to those for serial mode. The dialog is displayed below.
3

2

ILL 3850

1

À Sample Time
Sample time of first group.
Á Mode
The correlator can be split into 2,4 or 8 sections. Each section is a linear correlator starting from
the same time origin, but with different sample times.
Â Dilation
The ratio of the sample time of each group to the next. For example in multi-4 mode, and with a
sample time of 5 micro seconds, and a dilation of 4, the sample times of each section would be
5, 20, 80, 320us respectively.
Note also that the correlator control window is visible as an icon on the screen. Pointing at it with
the mouse and clicking will restore it to its former size. It can be resized like any other window.
The correlator page displays in detail the four sub correlator contents, and the associated monitor
values and far point.

Page A.2

Zetasizer 1000/2000/3000/4000/5000/4700

Artisan Scientific - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisan-scientific.com

Manual Correlator Control

MAN 0160

Options
This dialog provides options on enables us to select correlator size (we may cut down a large
correlator to speed up processing. Normally all available channels are used). We can also enable
prefill time (a delay before data accumulation while the correlator prefills. This is not normally
needed with the automatic routines as the order of settings provides implicitly for prefill), and
whether the manual settings we have made should override the normal default selections.
Other selections include Auto or cross correlation and the ‘test clock’. The latter provides a 1
MHz signal that overrides any external connection and may be used in verifying that the correlator
is functioning. Auto correlation is almost always used in PCS measurements, the light scattering
signal being multiplied by itself. In cross mode the A and B channels are multiplied, usually to
pull out a signal buried in noise, the signal having some fixed relationship to another signal
available to feed in to the B input.
Correlator select
Allows us to nominate which of 4 possible correlator systems is currently being handled. (usually
only 1 is fitted).
Prescale
The prescale values for each of the store subdivisions can be entered manually (1 - 256), or an
automatic routine called to set them, as outlined in the introduction to this chapter.
The 7032 correlator is controlled from an interface that plugs into the expansion bus of the PC.
It is normally set to use I/O locations 512 -515, through which single bytes of data are exchanged
with an external bus occupied by correlator data and control registers. In the event of any
apparent problems with accessing the correlator (ratemeter fails to operate, for example), it is
wise to unplug other devices whose I/O usage may conflict. No conflict has been reported with
devices (disks/printer cards etc. in common use)

A.4
A.4.1

70128 Correlator
Linear mode

This is the inbuilt correlator in the Zetasizer and Zetasizer S and is used for zetapotential
measurements in the Zetasizer 2000/3000.
The dialog is display below:

1

ILL 3846

3

2

À Sample time
Sets sample time of Correlator. Note that the hardware limits the minimum sample time , and
this will depend on store size. The fastest sample time in linear mode for 64 channels is 14.6 us,
whilst for 128 channels it 27.6 us.
Á Store Size
Sets required size of correlator. The options are 64, 128 and 256 channels.
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Â Duration
Duration of experiment in seconds.

A.4.2

Log mode

In log mode, a fixed sample time of 4us is used and the whole correlator consists of up to 128
channels split into groups of 8 channels with a fixed dilation of 2 between each group. The dialog
is displayed below.
3

ILL 3847

1

À Duration
Duration of experiment
Á Storesize
Choice between 64 and 128 channels.
Â Baseline
Because the correlator has no dedicated far point hardware, the average of long delay time
storechannels are used and this can be mixed with the calculated far point. Normally the
measured far point should be used. The Auto option avoids the need to specify the channel
numbers used in the far point.

A.4.3

Options

This dialog contains miscellaneous options.

ILL 3848

1

À Prefill
Allows prefilling of correlator
Test clocks 1 count/sampletime 1 count per n sample times 25KHZ sample time clock.

A.4.4

7132 Correlator

The 7132 Correlator has a dual correlator architecture. It has a fast 64 channel correlator which
can operate as a linear correlator, or a log correlator operating in 8 X 8 groups. It has a slower
DSP based correlator, which can operate as a 256 channel linear correlator with a minimum
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sample time of 10 us or a log correlator operating in 16x8 or 24x8 groups, with a fundamental
sample time of down to 4 us.
Linear mode As for 70128

A.4.5

Log mode.

The dialog is shown below.
3

ILL 3845

1

À Duration
Duration of experiment in seconds.
Storesize Standard is the default store size in which there are 192 channels Extended is only
recommended for experiments where very long sample times are required
Note: Specifying extended gives sample times up to 1260 seconds.
In operation this means a prefill time of 1260 seconds is required or
over 20 minutes..
Á Sample times
The fundamental sample times of the two correlators can be set independently. The fast
correlatator can use sample times of down to 50ns and upto 6.4 us. The slow correlator can use
sample times of down to 4us.
Â Baseline
Because the correlator has no dedicated far point hardware, the average of long delay time
storechannels are used and this can be mixed with the calculated far point. Normally the
measured far point should be used. The Auto option avoids the need to specify the channel
numbers used in the far point.
The DISPLAY menu provides a number of selections which are almost self explanatory. The
correlation function can be shown in full, or with the baseline subtracted. All channels can be
shown or only the ones selected under the currently set analysis method. The selected channels
can be shown packed together, or in their natural place in the correlator memory.
The RATEMETER or LIVE DISPLAY can be chosen as the default mode when the INSPECT
window (correlator control) comes up. Ratemeter operation is shown below. The count rate is
shown both in an analogue form (useful in alignment) and a digital form suitable for sample
concentration adjustment. The ‘counts per sample time’ figure is also calculated. For efficient
correlation it should ideally lie in the range 1 - 50 or so. High values of counts per sample time
will require prescaling to avoid overflowing the 8 bit processing limit, and mean count rates must
be well below the ceiling to avoid losses at extreme fluctuations. The B channel of the correlator
is also displayed.
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Autosizer Hi-C/Lo-C use it to transfer the temperature reading from the optics to the computer,
on a scale of 1000 Hz per degree. The diagram below shows the correlation function for a parallel
mode function, with background subtracted and chosen points only displayed, in a compressed
form. This S shape curve reveals the need to cover a wide time range. We see at short times
the function is nearly flat, the small sample time values at short delays being much less than the
signal coherence time. We then see a time range when the signal changes rapidly. Clearly the
correlator is well matched here to the signal structure. At longer times the curve is flat once more,
little further information being present at long time scales, confirming that all useful signal
information has been gathered.
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